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| Candy: Construction Computer Software - Candy Demo Job - 20

Candy Planning

Main Documents Procurement WUpdate Reports

lgg D E] L] 15| @ @ 'ﬁl & =) &) |Construction Program (Linked)

Construction Program (Linked): 1.1 Standard Barchart
Q:I Edit View Tools Barchart Histogram Progress Estimate

~
Utilities  Support
Eh s ¢ E@- s
= B ==/E
A0/ ODE @

Start: 01 Jul 19 End: 15 Jun 20 Time Mow: Not Updated

Acivity
Number

July 2019 August 2019 | September 2019 | October 2019

12) 19) 26| 2 9 18 23] 30/ & 13 20/ 27] 4] 11] 18[33

10|

A010 SITE ESTAELISHMENT
AQ20 Mobilise & resource
A030 Erect offices
A(040 FAN FOUNDATION (SECTION 2)
EARTHWORKS
Clear site/Remove topsoil
Excavate in bulk
Excavate founds and blind
Excavate footings & blind
Backfill to u/side of floor
FOUNDATIONS
Construct footings
Cable trench floor
cable trench walls
Fan base
surface bed
SUPERSTRUCTURE
Fan base walls
Fan base beams
Cure fan base beams
cut & fit duct covers
Joint sealing & finishes
STORMWATER DRAINAGE
Excavate
Bed & Tay
Backfill
Construct manhole 1
cure m/h 1 walls
Construct manhole 2
cure m/h 2 walls
FAN INSTALLATION
Install & bolt down
Connect up & test
Grout
Commission
SUB — STATION (SECTION 3)
EARTHWORKS
Clear site/Remove topsoil
Excavate founds & blind

Apc Tt Clcar site/Rameva topacil

80/83

vl TY1SS
-

B30 el s0) L eef Tl

Mobilise & rascurce

in bulk

Ana I N Excavata founds and Bind

420 TR Clzar site/Ram e topas
Az ) Excariate founds & blind

PC day 77 - 15 Oct 19 (Tug)

SitePlan program

Before a program is exported ensure that all the logic links, BOQ links,
etc. are correct
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What gets exported ?

Program
e Start date

e Multiple calendars with holiday/workday exceptions
e Summary headers as indented tasks

Activities

e Activity numbers (to TEXT 1 column in MSP)
e Activity descriptions

e Activity durations -- Start and End dates

e Precedence Logic
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What gets exported ?

Activity types
e Special activity types are exported as follow:
e Contract start = Must Start On
e Contract end = Finish No Later Than
e Target start = Start No Earlier Than
e Target end = Finish No Later Than
e B type = Start No Earlier Than

e H type = Normal activity with universal calendar (7days) allocation
e Tied (hammock) = normal activity (MS Project does not have such
a type )

e F type = normal activity (MS Project does not have such a type)

e \VV type = normal activity (MS Project does not have such a type)

e M type = normal activity (MS Project does not have such a type)

e K type = normal activity (MS Project does not have such a type)
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What does not get exported ?

Activities

e Remarks, notes and calculation sheets

e Base program and snapshots

e Special types i.e. T-types (SitePlan hammocks)
e Codes i.e. zone, area, etc.

e Time location data

e Information and Long lead schedules data

Resources
e No planning resources are exported
e No estimating resources are exported

General

e Only planning data mentioned in previous slides are exported.
e No other planning data are exported

e No BOQ linked data are exported.
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Program Manager

3
X®b=5 O

Export a Microsoft Project XML file (7]
Export a Primavera 6.7 to 6.8.2 XML file

Export a Prirnavera 6.7 XML file (include money)
Export a Primawvera 6.8.3 XML file

Export a MPX file
Export a Primavera 3 Batch file

Yiew | Tools
Imnport L |
Candy D Export..
(3 Curre .
c Adjust elapsed days for reports
[ Time Copy activity numbers to import ref
Rz Purge ALL progress from this program
By Print Programs
G
Bi Check program
@ Progs Check/Fix rescurce and BOQ links

Remove BOG links
Remowve Planning rescurce allocation

Leck\Unlock program

Diagnestic Tools r

Export the program
In the program manager highlight the program to be exported.
Select Tools > Export > Export a Microsoft Project XML

Remodelled Program

Original program by: Paul Planner
Original program date: 10 Dec 01

Latest revision by: Mike Manager
Latest revision date: 14 Jan 02

[ Mew 14 ] [Custumise] [Select]
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- g h
Fxport Text File
@Q*ﬂ@ ¥ Libraries » Documents » - ‘ +4 | | Search Documents R |
Organize - Mew folder 4= - (7]
4.7 Favorites — Documents IIbraI’y Arrangeby: Folder
M Desktop 1 Includes: 1 location ’
# Downloads MName Date modified =
L Recent Places | MS Office 30/04/2012 13:22
-: Dropbox L My CCs 30/05/2012 10:47
= i
a= SkyDrive Wy Data Sources 25/04/2012 12:10
. Wy Recerved Files 04,/04/2012 07:42
4
_ DE5|'¢C|'F|' @ M}f Shapes 26,/04/2012 12:07 —
P L
3 Libraries L My Stuff 25/05/2012 10:25| _
| P @ Documents . OneMote Motebooks 29/05/2012 14:46
. .
o Music | Outlook Files 30/05/2012 11:05
. .
e | Scanned Documents 18/03/2012 22:14 ~
b E Videos - 4 1] r
File name: Construction Program (Linked). XML -
Save as type: | All Files v]
“ Hide Folders sve | [ Concel
L A

Save XML file
Save the XML file in your destination of choice
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Program Manager @
View | Tools X3 O

Candy Demo Job - 2015
I;TE Current Planning Programs

Construction Program (Linked)

[Z]:Construct] 2 r2 20 413 Brejazs uUUIL i . 21 Apr 09
[ Time Locatiq Aug 15
Railway Li /= . ot yet
Bp Centrd Export to MS Project XML format »
Gold Min Mote that double links between activities (SSFF) will not be
Balanced exported.
@ Progress
This is becuase M5 Project will fail when importing them. Paul Planner
fe: 10 Dec 01
If this export is intended to be imported by Primavera 6.7 e M
then rather make use of the 'Export a Primavera 6.7 XML' : Anager
T 14 Jan 02

[ Mew I* ] [Customise] [5E|Ect]

Logic link difference warning
Take note that unlike Candy; MS Project does not allow you to link a
predecessor task twice to the same successor task.



Candy Planning Data Exchange — Microsoft Project®

Program Manager @
View RO X5 @
Candy Demo Job - 2015 Progress 28 May 2010
@ Current Planning Programs
® Time Location Programs Program Create date: 21 Apr 09
(3 Progress EXP OO T O TESS] 2 Oct 14
February _ Mot yet
P 188
rogress 3 &Y Export of progress 01
Progress 3
?ﬁ}};g}é;{i This program contains progress information.
e e -
MS Project can't import Candy Planning progress data - Paul Planner
accurately - it is recommeneded that progress data is NOT te: 10 Dec 01
exported. )
wvlike Manager
Do you want to include progress data in this export? =14 Jan 02
[ fes ] [ Mo ]

[ Mew I* ] [Custumise] [SEIect]

Progress export warning

Take note export of progress information is NOT recommended. MSP
calculates the progress different than Candy (or Primavera®); especially
% complete.
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Candy

Import Candy Planning
into Microsoft Project
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[P] Open =)
”~ - . T — —
W\ | | « Documents » My Documents » vt | Search My Documents P
Organize v New folder - i ®©
| B} Microsoft Project Documents Ilbrary Amrange by: Folder v
3 My Documents i
»{ Favorites Name D 4
B Desltop | MS Office
.‘ Downloads I My CCS
& Recent Places @) My Data Sources x
- Dého? I. OneNote Notebooks 2
89 Libadias | Outiook Files
5 Documents i, Scanned Documents it~
JW Music - ¢ m ’
ODBC...
File name: v | XML Format (*aomli) v
All Files (*.")
Tools ¥ Microsoft Project Files (".mp”)
| Projects (*.mpp) J
~ Project Databases (*.mpd) =

Project Templates (*.mpt)
Workspaces (".mpw)

MPX (*.mpx)

Microsoft Access Databases (".mdb)
Excel Workbook(* xdsx)

Excel Binary Workbook{" xisb)

Import the XML into MS Project
In MSP select File > Open. Change the file type XML format.

Select the relevant XML.
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Import Wizard - Import Mode ﬁ

How do you want to import this file?

(@ As a new project
(") Append the data to the active project

(71 Merge the data into the active project

> | (o) [ cone
L

Import the file as a New project
When the Import wizard displays, select the option “As a new project” >
Finish.
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r|E|| H9-o-|= \Gantt Chart Tools ‘ Construction Program (Linked) - Microsoft Project [E=RE
Task Resource Project View Add-Ins Format [ e B
_"‘3 ‘,* cut Calibri i mmesse E Mark nnT.rack - * @jlnspect - ; ¥ summary EE ko | Notes 34 Find -
E3 copy ~ - . ., 7 Respect Links [E) Move ~ & Milestone " [/ Details &P Clear =
Pa'ste - Format Painter U [S A g g < Inactivate zii‘:udilg schedule Mode = Ta'sk Deliverable Information T Add to Timeline ti(-;:llk @] Fini -
Clipboard Font Fl Schedule Tasks Insert Properties Editing
Textl , |ID , Task Name - |Duration ., |Start + (Finish - |Task Calendar [lanuary [February [march [Apr =
28/12[04/01[11/01[18/01[25/0101/02 [08/02 [15/02[22/02 [01/03 [08/03 [15/03[22/03[29/03[=
1 = SITE ESTABLISHMENT 15 days Mon 04/01/10 Fri22/01/10  Standard P———
A020 2 Mabilise & resource 10 days Mon 04/01/10 Fri15/01/10  Standard =—
AD30 3 Erect offices 10 days Mon 11/01/10 Fri 22/01/10  Standard =Q
4 = FAN FOUNDATION (SECT 205 days Mon 18/01/10 Fri29/10/10  Standard :
5 - EARTHWORKS 125days  Mon 18/01/10 Fri09/07/10  Standard
ADGO 6 Clearsite/Remove 20days  Mon 18/01/10 Fri12/02/10  Standard k5
A070 7 Excavate in bulk 20 days Mon 01/02/10 Fri26/02/10  Standard 4
ADBD 8 Excavate founds an 20 days Mon 08/02/10 Fri05/03/10  Standard : =;¢J
A0S0 9 Excavate footings & 20days  Mon 08/03/10 Fri02/04/10  Standard E jo—
A100 10 Backfill to u/side ot 40 days Mon 17/05/10 Fri09/07/10  Standard
11 = FOUNDATIONS 130 days Mon 08/03/10 Fri03/09/10  Standard P
Al120 12 Construct footings 20 days Mon 15/03/10 Fri09/04/10  Standard e
A130 13 Cable trench floor 20 days Mon 12/04/10 Fri 07/05/10  Standard
Al40 14 Cable trench walls 40 days Mon 10/05/10 Fri02/07/10  Standard
A150 15 Fan base 40 days Mon 08/03/10 Fri30/04/10  Standard "
Al6D 16 Surface bed 40 days Mon 12/07/10 Fri03/08/10  Standard
17 = SUPERSTRUCTURE 130 days Mon 03/05/10 Fri29/10/10  Standard
A180 18 Fan base walls 30 days Mon 03/05/10 Fri 11/06/10  Standard
A190 19 Fan base beams 20 days Mon 24/05/10 Fril8/06/10  Standard
A200 20 Cure fan base bean 40 days Mon 21/06/10 Fri13/08/10 Standard
A210 21 Cut & fit duct cover 20 days Mon 06/09/10 Fri 01/10/10  Standard
A220 22 Joint sealing & fini: 20 days Mon 04/10/10 Fri29/10/10  Standard
23 = STORMWATER DRAIN; 100 days Mon 05/04/10 Fri 20/08/10  Standard t
A240 24 Excavate 30 days Mon 05/04/10 Fril4/05/10  Standard
A250 25 Bed & lay 30 days Mon 19/04/10 Fri28/05/10  Standard
A260 26 Backfill 40 days Mon 28/06/10 Fri 20/08/10  Standard
A270 27 Construct manhole 20 days Mon 17/05/10 Frill/06/10  Standard
A280 28 Cure m/h 1walls 10 days Mon 14/06/10 Fri 25/06/10  Standard
A290 29 Construct manhole 20 days Mon 14/06/10 Fri09/07/10  Standard
A300 30 Cure m/h 2walls 10 days Mon 12/07/10 Fri23/07/10  Standard
31 ~ FAN INSTALLATION 51 days Mon 09/08/10 Mon 18/10/10 Standard
A320 32 Install & bolt down 20 days Sat14/08/10 Mon 06/09/10 6 Day Working
A330 33 Connectup &test 30 days Mon 09/08/10 Sat11/03/10 6 Day Working :
- - S m
#* New Tasks : Manually Scheduled | [EEEe O

End result
Open the project and check dates, calendars and calendar allocation as
well as holiday exceptions
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\El H Lrls |= |.“"_|J_|_."_r_|_ul,_w.;| Construction Program (Linked) - Microsoft Project |E@é’
Task Resource Project View Add-Ins Format 2] e B
_J—"‘j * cut Calibri - mmees z Mark nnTrack - #. @_‘Inspect - HSL!mmary EE k| Notes 4 Find -
53 Copy ~ . - Respect Links E&y Move ~ Q Milestone X :l Details 2 Clear ~
ciZWmat Painter @ U O A aE 68 e B o Monual e | B Mode - | " igpe Information T Add to Timeline gl 3] it -
Vi | Font El Schedule Tasks Insert Properties Editing
Textl  |ID ), Task Name . Duration  |Start - |Finish - |Task Calendar [1anua February [March [Apr »
28/12[04/01][11/01[18/01[25/01[01/02 [08/02 [15/02[22/02 [01/03 [08/03[15/03 [22/03 | 29,!03@
= SITE ESTABLISHMENT 15 days Mon 04/01/10 Fri22/01/10  Standard
2 |a020 2 Mobilise & resource 10 days Mon 04/01/10 Fri15/01/10  Standard | —
3 |A030 3 Erect offices 10 days Mon 11/01/10 Fri22/01/10  Standard =Q
4 4 ~ FAN FOUNDATION (SECT 205 days Mon 18/01/10 Fri29/10/10  Standard
5 5 - EARTHWORKS 125 days Mon 18/01/10 Fri09/07/10  Standard
& ABD 6 Clearsite/Remove 20days  Mon 18/01/10 Fri12/02/10  Standard B
7 |a070 7 Excavate in bulk 20 days Mon 01/02/10 Fri26/02/10  Standard 4
8 |A0B0D 8 Excavate founds an 20 days Mon 08/02/10 Fri05/03/10  Standard ==¢J
2 A0%0 9 Excavate footings § 20days  Mon 08/03/10 Fri02/04/10  Standard —
10 |A100 10 Backfill to u/side o' 40 days Mon 17/05/10 Fri0s/07/10  Standard
i1 11 ~ FOUNDATIONS 130 days Mon 08/03/10 Fri03/09/10 Standard e
12 |p120 12 Construct footings 20 days Mon 15/03/10 Fri09/04/10  Standard —
13 |A130 13 Cable trench floor 20 days Mon 12/04/10 Fri07/05/10 Standard
14 |pA140 14 Cable trench walls 40 days Mon 10/05/10 Fri02/07/10  Standard
5 a150 15 Fan base 40days  Mon 08/03/10 Fri30/04/10 Standard "
16 |A160 16 Surface bed 40 days Mon 12/07/10 Fri03/09/10  Standard
17 17 = SUPERSTRUCTURE 130 days Mon 03/05/10 Fri29/10/10 Standard
18 |A180 18 Fan base walls 30 days Mon 03/05/10 Fri11/06/10 Standard
13 |A190 19 Fan base beams 20 days Mon 24/05/10 Fri18/06/10  Standard
20 |A200 20 Cure fan base bean 40 days Mon 21/06/10 Fri13/08/10  Standard
21 |A210 21 Cut & fit duct cover 20 days Mon 06/09/10 Fri01/10/10  Standard
21 |a220 22 Joint sealing & finic 20 days Mon 04/10/10 Fri29/10/10  Standard
23 23 = STORMWATER DRAIN) 100 days Mon 05/04/10 Fri20/08/10  Standard t
24 |A240 24 Excavate 30 days Mon 05/04/10 Fri14/05/10 Standard 1
25 |A250 25 Bed & lay 30 days Mon 19/04/10 Fri28/05/10  Standard
26 |A260 26 Backfill 40 days Mon 28/06/10 Fri20/08/10  Standard
27 |A270 27 Construct manhole 20 days Mon 17/05/10 Fri11/06/10 Standard
28 |A280 28 Curem/h1walls 10 days Mon 14/06/10 Fri25/06/10  Standard
23 |A290 29 Construct manhole 20 days Mon 14/06/10 Fri09/07/10  Standard
30 |A300 30 Curem/h2walls 10 days Mon 12/07/10 Fri23/07/10  Standard
31 31 =~ FAN INSTALLATION 51 days Mon 09/08/10 Mon 18/10/10 Standard
32 |A320 32 Install & bolt down 20 days Sat14/08/10 Mon 06/09/10 6 Day Working
33 |A330 33 Connect up &test 30days Mon 09/08/10 Sat 11/09/10 6 Day Working
im T C |4 m| 3
Ready | 5? New Tasks : Manually Scheduled | \@E EHE (=) &)

Activity comparison
The Candy activity numbers are copied into the TEXT 1 column in
Add the TEXT 1 column to see the activity numbers.

MSP.
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Logic differences between SitePlan and MSP
A Start Lead in MSP is the number of days from the start of a
predecessor to the start of the successor.

A Start Lead in SitePlan is the number of days of work done in
the predecessor before the successor can start.

This will cause differences in results when there is progress out
of sequence.

The same applies to End Lags.

MSP does not allow that you link a predecessor task twice to
the same successor , Candy does.

During the conversion the one link is dropped and this might
lead to a difference in dates when comparing back to Candy.
The links might have to be corrected manually.

.
Microsoft Project Iﬁ
There was a problem linking these tasks.
l “  You cannotlink a predecessor task twice to the same successor task.

MS Project is a registered trademark of Microsoft .
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Disclaimer

Due to differences in calculation and
the activity types between products
the responsibility for validating the
results must lie with those providing
the export file and those doing the
import.

MS Project is a registered trademark of Microsoft .
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How does logic get exported?

Single links
eStart lead only (Start to Start) link = no problem
eEnd lag only (End to End) link = no problem

Double links
eBoth Start to Start AND End to End link = potential problem



Candy Planning Data Exchange — Microsoft Project®

Potential logic link problem
= double links?

Start link “elbow”
eEnd to end link is the driving link
eStart to Start link gets dropped = No problem

October 2012 | Movember 2012
Act Current Imposed | 5| 12 1g| 26 2| a 15| 23 3
T N Activity Description Durn | Start Finish Date  Float |, ., 10/ 20 30 40
=3 A020 start Tink "elbow" 28 11 Oct 12 19 Nov 12 0
s AD30 Contract start activity 1 11 oct 12 11 oct 12 11 oct 12 0 A rt activity
AD40 Activity A 20 12 oct 12 08 Nowv 12 0 A04 Activity A
AQS50 Activity B 20 23 Oct 12 19 Nov 12 0 Activity B
Candy _ |Task Name . |Duration _|start - |Finish - |Constraint . |Free _ |Constraint Type - | [ November
Act#t Date slack 08/10[15/10[22/10[29/10[05/11[12/11[19/1
= Start link "elbow" 28 days 11 Oct '12 19 Nov '12 NA Odays AsSoon As Possible Py
AD30 Contract start activity 1day 11 0ct'12 11 0ct'12 11 Oct'12 Odays  MustStart On :
AD40 Activity A 20 days 12 Oct'12 08 Nov 12 MNA Odays AsSoon As Possible
AD50 Activity B 20 days 23 0ct'12 19 Nowv 12 MA Odays  AsSoon As Possible
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Potential logic link problem
= double links?

End link “elbow”
eStart to start link is the driving link
eStart to Start link gets dropped = Problem

October 2012 | November 2012 Dec{
Act Current Imposed | 5 12| 19| 26/ 2 9 16 23 30 I
T N° Activity Description Durn | Start Finish Date Float | .. . 100 . 200  .300 40 . .90 .
=3 A060 End link "elbow" 28 12 Oct 12 20 Nov 12 0 |

AQ70Q Activity C 20 12 Oct 12 08 Nov 12 0 ADTO
AQBO Activity D L. 20 23 Oct 12 19 Nov 12 0 I Activity D
e AQ90 Contract End activity 1 20 Nov 12 20 Nov 12 20 Nov 12 0 Do ontract End activity
Candy - Task Name Duration _ |Start - Finish Constraint Free _ |Constraint Type - | T | Movember
Act# Date slack 08/10[15/10][22/10[29/10[05/11[12/11[18/11]
= End link "elbow" 28 days 12 Oct '12 20 Nov '12 NA Odays AsSoon As Possible
AOT0 Activity C 20 days 12 Oct 12 03 Nowv '12 NA Odays  AsSoon As Possible
AOZ0 Activity D 20 days 17 Oct 12 13 Nov 12 NA 3days |AsSoon As Possible
A0S0 Contract End activity 1day 20 Nov '12 20 Nov "12 20 Nov "12 Odays  Finish Mo Later Than
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Recommended checks
Contract starts and ends; Target starts and ends are
exported as constraints. Ensure that these constraints
are set correctly in MSP.

All calendars are exported, but check that the holidays
and non-work days are set correctly in each calendar.

A (T)ied activity is not used in MSP and Tied activities
are exported as Normal activities. One of the Tied
activity’s links is discarded during the conversion
process.

The Candy activity number is copied into the TEXT 1
column in MSP for comparison back to Candy after
import into MSP.

MS Project is a registered trademark of Microsoft.




Candy Planning Data Exchange — Microsoft Project®

Disclaimer

Due to differences in calculation and
the activity types between products
the responsibility for validating the
results must lie with those providing
the export file and those doing the
import.

MS Project is a registered trademark of Microsoft .
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Candy

Import MS Project XML file
into Candy Planning
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H ©- &- [d GenttChat ~| = GANTT CHARTTOOLS  Construction Program - Project Professional ? - 0O X
TASK RESOURCE REPORT PROJECT VIEW FORMAT - x
“D 3{; Calibri n - ? g % % # ﬂ Mark on Track - » % = Inspect - +- = Summary m '& -
Eg - o » < Respect Links . E‘ Move = . P Milestone X e~
Cia::- PE‘EtE ¥ Bl7u & A- e % @G = Inactivate f;d;r;udau\:,e Sc‘::;‘:ﬂe E"_}Mocle' Ta:k Deliverable fnfermatien bz Add to Timeline toScTr:llk -
View Cliphoard Font & Schedule Tasks Insert Properties Editing ~
January February March April -
ID + | Task Name ~ Duration +  Start ~  Finish 21412 2812 04/01 11,01 18/01 25/01 01/02 0802 1502 22/02 01/03 0803 1503 22/03 29/03 0504 1204
1 |1 |A SITE ESTABLISHMENT 15days Mon04Jan'10  Fri22Jan'10 1 ‘ ‘ ‘ ‘ ‘ ‘ ‘
2z |2 Mobilise & resource 10days Mon04Jan'l0  Fril5Jan'10 ] .
303 Erect offices 10days Mon1lJan'l0  Fri22Jan'l0
4 a 4 FAN FOUNDATION (SECTION 2) 205days Mon18Jan'10  Fri29 Oct'10
5 |5 4 EARTHWORKS 125days Mon18Jan'10  Fri 09 Jul '10
6 |6 Clearsite/Remove topsoil * 20days  Mon18Jan'l0  Fril2fFeb'l0 | |
7|7 Excavate in bulk 20days MonOlFeb'l0 Fri26Feb'10
i 08 Excavate founds and blind 20days  Mon08Feb'l0  Fri05 Mar'10
9 |9 Excavate footings & blind 20days  Mon 08 Mar 10 Fri 02 Apr '10
10 |10 Backfill to u/side of floor 40days  Mon 17 May '10  Fri 09 Jul '10
1111 < FOUNDATIONS 130 days Mon 08 Mar'10  Fri 03 Sep '10
12 |12 Construct footings 20days  Mon 15Mar '10  Fri 09 Apr '10
£ 13 |13 Cable trench floor 20days  Mon12 Apr'l0  Fri07 May '10
‘Ic 14 14 Cable trench walls 40days  Mon 10 May '10  Fri 02 Jul '10
E 15 |15 Fan base 40days  Mon 08 Mar'10  Fri 30 Apr'10
E 16 |16 Surface bed 40days  Mon 12 Jul'10  Fri03 Sep '10
w17 1y < SUPERSTRUCTURE 130days Mon 03 May "10  Fri 29 Oct '10
18 |18 Fan base walls 30days  Mon 03 May'10  Fri1lJun'10
19 |19 Fan base beams 20days  Mon 24 May '10  Fri 18 Jun '10
0 |20 Cure fan base beams 40days  Mon21Jun'10  Fril3 Aug'l0
a (21 Cut & fit duct covers 20days  Mon 065ep'10  Fri 01 Oct'10
2 |22 Joint sealing & finishes 20days Mon 04 Oct'10  Fri29 Oct'10
3 |23 < STORMWATER DRAINAGE 100 days Mon 05 Apr'10  Fri 20 Aug '10
24 |24 Excavate 30days Mon05Apr'l0  Frild May '10
25 |25 Bed & lay 30days Mon19Apr'il0  Fri 28 May '10
% |26 Backfill 40days  Mon 28 Jun'10  Fri 20 Aug'10
27 |27 Construct manhole 1 20days  Mon 17 May'10  Fri 11 Jun '10
28 |28 Cure m/h 1 walls 10days  Mon14Jun'10  Fri25Jun ‘10
29 |29 Construct manhole 2 20days  Mon14Jun'10  Fri09Jul '10
30 |30 Cure m/h 2 walls 10days  Mon 12 Jul '10 Fri 23 Jul '10

UALLY SCHEDULED

Microsoft Project program
In Microsoft Project (MSP) select File > Save as
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©

Save As

New

Save and Sync E;I Computer
Open - -
() . . Save As u
) \_)rlj Sync with SharePoint =
Save @u,‘ 3 v Libraries » - |&f‘ | Search Libraries )
Save As Organize = o @
&& OneDrive "
Print ) _ Libraries
W Favorites Open a library to see your files and arrange them by folder, date, and other pr...
Share = Deskt
Share ED Computer Bl Deskiop e _
- &% Downloads & Documents
5l Recent Places ‘_;\_/b, Library
- o= Add aPlace 2 Dropbox
Close [E] Pictures ? Music
& OneDrive —~ Libsary
Account B Deskiop ;4 P.ictures
<~ Library
= Libraries
Options
@ Documents u Videos
és Music S, Library
[ Pictures -
File nam{‘ _Con;truction Program.xml ’ -
Save as type: IXML Format (*xml) v]
Project (*.mpp)
) Microseft Project 2007 (*.mpp)
* Hide Folders Microseft Project 2000 - 2003 (*.mpp)
Project Template (*.mpt)
S Microsoft Project 2007 Templates (*.mpt) P
PDF Files (*.pdf)
XPS Files (*xps)
Excel Workbook(*.xdsx)
Excel Binary Workbook(*.xlsh)
Excel 97-2003 Workbook (*.ds)
Text (Tab delimited) (*.bet)

C5V (Comma delimited) (*.csv)
XML Format (*.xml)

Save as a XML type file
Select Browse > Change “"Save as type” to "XML format (*.xml)"
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&
View | Tools | R4 7]
Import Import the Bill of Quantities
New Jok Export » Import from another program
QEiI-Frll . ' General importer (XML, MPX, OUT, CSV, XLS, XLSX) &)

Last Access date: Mot yet

Last Backup date: Mot yet
Print Programs Program No.

Revision No.

Diagnostic Tools

[ Mew I* ] [Customise] [5E|Ect]

Import the program

In the program manager select Tools > Import > General importer (XML ...)
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Analysis display

= O [=l=]E
O e @

=Construction Program.xml 0
Start=2010-01-04

End=2010-11-15

DNOW=2010-01-04

Week starts on day 1 (1=Monday)
Days in week=5

Default calendar = 2

Hours per day 8

Mins per per day 480

Durn format 7

m

ZMNEW M5SP XML IMPORT

2 calendars

=istandard

{is deault}, id=2, day/week=5
=b_Day Working

{1}, id=3, day/week=6

=6l acts to import -
52 logic recs

Lt e bbb ] ] e

Analysis display

At the end of import process an analysis report will be displayed.

If any conversion problems were encountered it will also be included in
the report.
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What gets imported?

Program

e Start date

e Multiple calendars with holiday/workday exceptions
e Summary headers as indented tasks

Activities

o Activity ID (to Import reference column in Candy)
o Activity descriptions

e Activity durations -- Start and End dates

e Precedence Logic

Activity types
e Special activity types are imported as follow:
e Must Start On = Contract start
e Finish No Later Than = Contract end
e Start No Earlier Than = Target start
e Finish No Later Than = Target end
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What does not get imported?

Activities

e Base program and snapshots
e Special task types

e Milestone mark

e User defined columns

Resources
e No resources are imported
e No resource calendars are imported
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Program Manager @
View Tools X ﬁ'ﬁ @ @ @
New Job Construction Program.xml
(3} Planning Program heading

Construction Program.xml Program Create date: 22 Sep 15
Last Access date: 22 Sep 15
Last Backup date: Mot yet

Program No.
Revision No.

[ Mew I* ] [Custumise] [ SEIE::I:]

Imported program in Program manager
The imported program will be added to the program manager. Select the
program.
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Planning documents Manager
<r':| View Tools xﬁ@@ @
Construction Program.xml
tﬁi 1. Barcharts
[ 1.1 Standard Barchart;
Column layout @

Choose the columns for document: 1.1 Standard Barchart

Available Columns Selected Columns
7 Predecessors |1k 121 Activity tyeoe (T |
B Activity Codes 165 imporcd referace_|})
9 Calendar i v s ATty TTOrTEr (AT
10 Activity Miscellaneous B |23 Activity description
101 Activity remark 2 v 24 Activity duration
10.2 Activity note 1 Q:l 3.2 Current start date (ES)
10.3 Yellow tag é;:. 3.3 Current finish date (EF)
104  Drawing number % 11 Barchart window
10.5 Unique ID
106  Activity create date
=
| ok || Cancel || Help |

———
[ Mew documen{l’[ Customise ] ﬁelect ]

Customise a view to include “"Import reference "
Add the import reference column to your document view to see the MSP
activity Id for comparison.
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Construction Program.xml: 1.1 Standard Barchart == @@

<::| Edit View Tools Barchart Histegram Progress Estimate [} -_)'nJ x ﬁ [Es] @ @] @
Start: 04 Jan 10 End: CALCULATE Time Now: Not Updated

January 2010 February 2010 March 2010
T t Current 8 15 221 29 5 12 19, 26 5 12 19 26
e Activity Description Durn Start Finish 10 20 30 40 50 <0
= D001 SITE ESTABLISHMENT 0 04 Jan 10 q‘] -~
S 2 0002 “MobiTise & resource 10 04 Jan 10 15 Jan 10 b Mobilise & resource 0
B 3 0003 Erect offices 10 04 Jan 10 15 Jan 10 v Erect offices
=1 4 0004 FAN FOUNDATION (SECTION 2) 0 04 Jan 10
=2 5 0005 EARTHWORKS 0 04 Jan 10
6 0006 Clear site/Remove topsoil 20 04 Jan 10 29 Jan 10 = L Clear site/Remove topsoil
7 0007 | Excavate in bulk 20 04 Jan 10 29 Jan 10 b Excavate in bulk
8 0008 Excavate founds and blind 20 04 Jan 10 29 Jan 10 b Excavate founds and blind
9 0009 Excavate footings & blind 20 04 Jan 10 29 Jan 10 = E===0 Excavate footings & blind c
10 0010 Backfill to u/side of floor 40 04 Jan 10 26 Feb 10 = b Backfill to u/side of floor |
=2 11 0011 FOUNDATIONS 0 04 Jan 10
12 0012 Construct footings 20 04 Jan 10 29 Jan 10 b Construct footings
13 0013 cable trench floor 20 04 Jan 10 29 Jan 10 = L Cable trench floor
14 0014 cable trench walls 40 04 Jan 10 26 Feb 10 = EEsss——— Cable trench walls
15 0015 Fan base 40 04 Jan 10 26 Feb 10 = PSS Fan base
16 0016  surface bed 40 04 Jan 10 26 Feb 10 = Surface bed
=2 17 0017 SUPERSTRUCTURE 0 04 Jan 10 A
18 0018 Fan base walls 30 04 Jan 10 12 Feb 10 = bFamtbasewlls
19 0019 Fan base beams 20 04 Jan 10 29 Jan 10 s Fan base beims
20 0020 Cure fan base beams 40 04 Jan 10 26 Feb 10 = Cure fan base beams
21 0021 Cut & fit duct covers 20 04 Jan 10 29 Jan 10 = Eut-&-fit-chugt-covers
22 0022  Joint sealing & finishes 20 04 Jan 10 29 Jan 10 = L Joint sealing & finishes
=2 23 0023 STORMWATER DRAINAGE 0 04 Jan 10
24 0024 Exgavaace gg gi Jan %g g FeE %g 1 L Excavate
25 0025 Bed & lay Jan Fe bfed& lay
26 0026 Backfill 40 04 Jan 10 26 Feb 10 m e B —— Backfil
27 0027 Construct manhole 1 20 04 Jan 10 29 Jan 10 = 6 Comstrct-manhole|1
28 0028 Cure m/h 1 walls 10 04 Jan 10 15 Jan 10 & Cure-myrifalls
29 0029 Construct manhole 2 20 04 Jan 10 29 Jan 10 = Construct manhole|2
30 0030 Cure m/h 2 walls 10 04 Jan 10 15 Jan 10 E=======ttcuremyhafratts
=2 31 0031 FAN INSTALLATION 0 04 Jan 10
32 0032 Install & bolt down 20 04 Jan 10 26 Jan 10 FE—=========U-ingtyit-frboltdownr—————
33 0033 Connect up & test 30 04 Jan 10 06 Feb 10 ﬁ- Connect up & test
34 0034 Grout 10 04 Jan 10 15 Jan 10
35 0035 Commission 20 04 Jan 10 26 Jan 10 Commission
=1 36 0036 SUB — STATION (SECTION 3) 0 04 Jan 10
=2 37 0037 EARTHWORKS 0 04 Jan 10
38 0038 Clear site/Remove topsoil 20 04 Jan 10 29 Jan 10 Clear site/Remove topsoil
39 0039 Excavate founds & blind 20 04 Jan 10 29 Jan 10 Excavate founds & blind rlals
40 0040  Excavate footings & blind 20 04 Jan 10 29 Jan 10 Excavate footings & blind x>
A T | b d] -
PC day 58 - 24 Mar 10 (Wed) |Calculate =

Calculate the program
Press the Calculate button to calculate the imported program.
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Construction Program.xml: 1.1 Standard Barchart = O ==&
<o Edit View Tools Barchart Histogram Progress Estimate a8 x ﬁ B =) @ (7]
Start: 04 Jan 10 End: 15 Nov 10 Time Now: Mot Updated
2010
3z Import Act Current Jan Feb Mar Apr May Jun
T Reference N? Activity Description Durn Start Finish 10/ 200 30 40 500 60 70 80 80 100 110 J20
=21 1 0001 STTE ESTABLISHMENT 15 04 Jan 10 22 Jan 10 | o
5|2 0002 MobiTise & rekource 10 04 Jan 10 15 Jan 10 Mobilise & resource i
B 3 003 Erect offices 10 11 Jan 10 22 Jan 10 Erect offices
=1 4 0004 FAN FOUNDATION (SECTION 2) 205 18 Jan 10 29 Oct 10
=2 5 0005 EARTHWORKS 125 18 Jan 10 09 Jul 10
6 0006 Clear site/Remove topsoil 20 18 Jan 10 12 Feb 10 ooos Clear site/Remove topsail
7 0007  Excavate in bulk 20 01 Feb 10 26 Feb 10 00071 Excavate in bulk
8 0008 Excavate founds and blind 20 08 Feb 10 05 Mar 10 Excavate founds and blind
] 0009 Excavate footings & blind 20 08 Mar 10 02 Apr 10 Excavate footings & blind L
10 0010 Backfill to u/side of floor 40 17 May 10 09 Jul 10 - I— |
=2 11 0011 FOUNDATIONS 130 08 Mar 10 03 Sep 10
12 0012 Construct footings 20 15 Mar 10 09 Apr 10 foatings
13 0013 cCable trench floor 20 12 Apr 10 07 May 10 Cable trench floor
14 0014 cCable trench walls 40 10 May 10 02 Jul 10
15 0015 Fan base 40 08 Mar 10 30 Apr 10 001 Fan base
16 0016  Ssurface bed 40 12 Jul 10 03 sep 10
=2 17 0017 SUPERSTRUCTURE 130 03 May 10 29 Oct 10 i
18 0018 Fan base walls 30 03 May 10 11 Jun 10 001 Fy
19 0019 Fan base beams 20 24 May 10 18 Jun 10 [olaJ T . |
20 0020 Cure fan base beams 40 21 Jun 10 13 Aug 10
21 0021 Cut & fit duct covers 20 06 Sep 10 01 oct 10
22 0022 Joint sealing & finishes 20 04 oct 10 29 oct 10
=2 23 0023 STORMWATER DRATINAGE 100 05 Apr 10 20 Aug 10
24 0024 Excavate 30 05 Apr 10 14 may 10 002 Excavate
25 0025 Bed & lay 30 19 Apr 10 28 May 10 0025
26 0026 Backfill 40 28 Jun 10 20 Aug 10 ’
27 0027  Construct manhole 1 20 17 May 10 11 Jun 10 002 Ce
28 0028 Cure m/h 1 walls 10 14 Jun 10 25 Jun 10 002
29 0029 Construct manhole 2 20 14 Jun 10 09 Jul 10 Jolajels
30 0030 Cure m/h 2 walls 10 12 Jul 10 23 Jul 10
=2 31 0031 FAN INSTALLATION 51 09 Aug 10 18 Oct 10
32 0032 1Install & bolt down 20 14 Aug 10 06 Sep 10
33 0033 Connect up & test 30 09 Aug 10 11 Sep 10
34 0034  Grout 10 13 Sep 10 24 Sep 10
35 0035 Commission 20 25 Sep 10 18 oct 10
=1 36 0036 SUB — STATION (SECTION 3) 195 15 Feb 10 12 Nov 10
=2 37 0037 EARTHWORKS 45 15 Feb 10 16 Apr 10
38 0038 Clear site/Remove topsoil 20 15 Feb 10 12 Mar 10 0035 |car site/Remove topsoil
39 0039 Excavate founds & blind 20 22 Feb 10 19 Mar 10 0030 I £ vate founds & blind rlal
40 0040  Excavate footings & blind 20 22 Mar 10 16 Apr 10 0040 £ cavate footings & b4 [X]F
C ) Fe—— y (=4~
PC day 114 - 10 Jun 10 (Thu) [ Calculate | « |

Import complete
Once complete check & compare the calendar, holidays and activity dates.
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Recommended checks
Constraints are imported as Contract starts and ends;
Target starts and ends. Ensure that these constraints are
set correctly in Candy.

Only calendars that are used in MSP are imported, check
that the holidays and non-work days are set correctly in
each calendar.

No user defined columns are imported from MSP
The MSP activity ID is copied into the Import reference

column in Candy for comparison back to MSP after
import.

MS Project is a registered trademark of Microsoft .
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Disclaimer

Due to differences in calculation and
the activity types between products
the responsibility for validating the
results must lie with those providing
the export file and those doing the
import.

MS Project is a registered trademark of Microsoft .




